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１．はじめに 

 

1.1 本書の役割 

 

本書は、App Bridge Transporter の概要、及びサービスを利用するための操作について記載しています。 

 

1.2 前提ドキュメント 

 

 本書は、以下のドキュメントを前提に記載されています。本書をご覧いただく前にご一読下さい。 

 

⚫ App Bridge ファーストステップガイド 

⚫ App Bridge 管理者ガイド 

 

1.3 モジュールの前提条件 

 

 App Bridge Transporter が利用者向けに提供するモジュールの対象 OS、前提条件は、以下のドキュメン

トに記載されています。 

 

⚫ Windows Agent サポートリスト 
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２．概要 

 

2.1 App Bridge Transporter とは 

 

 App Bridge Transporter（以下本サービス）は、クラウドストレージを使った新しいファイル転送サー

ビスであり、次のような特長を有しています。 

 

⚫ 今まで難しかった GB～TB サイズの大容量ファイル転送を可能にします 

⚫ インターネットを介してのファイル転送を安全・確実に実現します 

⚫ センタへの HTTPS 通信のみを使用するため、導入が容易です 

⚫ ファイル転送ベースの開発、バックアップ運用など、様々な用途にご利用いただけます 
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2.2 ファイル転送方式 

 

 本サービスは、ファイルを小さな断片（ピース）に分割し、クラウドストレージに並列転送します。 

このピースサイズと並列転送数を制御することで、目的の転送スピードに合わせたファイル転送を実現

しています。 

 

 

 

2.3 安全性の確保 

 

 クラウドストレージに格納するピースは、ピースごとに生成した暗号キーで暗号化され、意味のない名

称で保存されます。このため、第三者がピースから元データを生成することはできません。 

 

 ピースの名称、暗号キーなどが記載されたマップ情報は、当社センタで保管されています。ピースとマ

ップ情報を異なる場所に保存することで、安全性を確保しています。 

 

 

  

インターネット 

マップ 

情報 

マップ 

情報 
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2.4 完全性の確保 

 

 ピースのアップロード時にはクラウドストレージでハッシュを確認し、ダウンロード時には Agent でハ

ッシュを確認します。ハッシュが一致しなければ当該ピースは再送対象となります。ピースごとの完全性

を確保することで、ファイル全体の完全性を確保し、再送範囲も最小化しています。 

 

 

 

2.5 容易な導入 

 

 ファイル転送に使用される通信は、センタに対する HTTPS 通信のみです。プロキシサーバにも対応して

いるため、既存のネットワーク環境を変更することなく、導入が可能です。 

 また、ファイル転送時に目標帯域の指定が可能であり、既存のインターネット帯域を使い切ることはあ

りません。このため、既存のインターネット環境を変更することなく、ファイル転送を導入することがで

きます。 

 

 
 

  

Upload Download 

   ハッシュ確認 ハッシュ確認 

App Bridge センタ 

HTTPS HTTPS 

HTTPS HTTPS 
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2.6 ブラウザによる管理機能 

 

 本サービスの管理機能は、全てブラウザ経由で提供され、各種設定に加え、ファイル転送の状況照会、

リラン、キャンセルを実施することができます。 

 

 アップロードされたデータは、事前の設定に従い、センタ側で世代管理、満了日管理が実施されます。 

 

 
 

  

マップ 

情報 
マップ

情報 

データ制御 

・世代管理 

・満了日管理 

HTTPS
 

App Bridgeセンタ 

ブラウザ 

・各種設定、転送状況照会 

・リラン、キャンセル 
管理者 
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３．システム構成 

 

3.1 管理単位 

 

 本サービスでは、「データセット」、「アップロード履歴」、「ダウンロード履歴」を管理単位とします。 

 

3.1.1 データセット 

 

 データセットは、転送するファイルの種類を表す単位であり、通常、「XXX データベースバックアップ」

や「XXX 販売データ」などのファイル種類ごとにデータセットを作成します。オーナ内にデータセットを

複数作成することができ、作成数に制限はありません。 

 データセットでは、世代数管理や満了期限などの属性を設定します。これにより、「XXX データベースバ

ックアップは 3 世代管理する」、「XXX 販売データは 30 日間保管する」など、アップロードファイルの柔軟

な管理が可能となります。 

 

 

 

3.1.2 アップロード履歴 

 

 アップロード履歴は、アップロードを実行する度に作成される履歴情報です。アップロードを実施する

際、対象のデータセットを指定します。作成されたアップロード履歴は、指定されたデータセットに従属

します。1 つのアップロード履歴は 1 つのアップロードファイルを指します。 

 

 

  

オーナ 

データセット 

データセット 
データセット 

データセット 

データセット 

データセット 
アップロード履歴 



 

- 7 - 

 

3.1.3 ダウンロード履歴 

 

 ダウンロード履歴は、ダウンロードを実行する度に作成される履歴情報です。ダウンロードを実施する

際、対象のアップロード履歴を指定します。作成されたダウンロード履歴は、指定されたアップロード履

歴に従属します。同じアップロード履歴は、アップロードファイルが削除されない限り、何度でもダウン

ロード可能であり、ダウンロードする度にダウンロード履歴が作成されます。 

 

 

 

  

アップロード履歴 

データセット 

データセット 
ダウンロード履歴 
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3.2 ID 仕様 

 

3.2.1 データセット ID 

 

 データセットを一意に識別するための ID です。データセット作成時に一意な ID として生成されます。 

 

3.2.2 アップロード ID 

 

 アップロード履歴を一意に識別するための ID です。アップロード開始時に一意な ID として生成されま

す。 

 

3.2.3 ダウンロード ID 

 

 ダウンロードを一意に識別するための ID です。ダウンロード開始時に一意な ID として生成されます。 

 

3.2.4 ホスト ID 

 

 ホストを一意に識別するための ID であり、Windows SID を基準に生成されます。アップロードのリラン

処理などで使用されます。 

 

3.2.5 ファイル ID 

 

 ファイルを識別するための ID であり、以下の情報を基準に生成されます。アップロードのリラン処理な

どで使用されます。 

 

⚫ データセット ID 

⚫ ホスト ID 

⚫ ファイルパス 

⚫ ファイル作成日時 
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3.3 データセットタイプ 

 

3.3.1 データセットタイプの種類 

 

 本サービスでは、方式の異なる 2 つのデータセットタイプ（Standard と Extension）を準備しています。

データセットタイプは、前述のデータセットごとに設定することができます。 

 

 

項目 

データセットタイプ  

Standard Extension 

使用するクラウドストレージ 本サービスが提供するストレージ 利用者が準備したストレージ 

課金方式 標準課金 拡張課金 

S3 Transfer Acceleration（※1） 不可 可 

※1： S3 Transfer Acceleration は、長距離におけるファイル転送を高速に行うためのサービスです。 

詳細は Amazon S3 Transfer Acceleration を参照下さい 

 

3.3.2 Standard の課金 

 

 データセットタイプ Standard の課金（標準課金）は、利用量に応じた従量課金です。利用料にはクラウ

ドストレージ使用料、クラウドストレージのデータ通信料が含まれます。 

 

項目 単位 単価 備考 

ファイルアップロード料 回 1.0 円 アップロード成功分のみ課金 

ファイル保管料 GB/日（※1） 1.0 円 アップロード成功分のみ課金 

ファイルダウンロード料 MB/回（※2） 0.1 円 ダウンロード成功分のみ課金 

※1：GB 未満の値は GB 単位に切り上げられます。この切り上げはアップロードごとに実施されます 

※2：MB 未満の値は MB 単位に切り上げられます。この切り上げはダウンロードごとに実施されます 

 

3.3.3 Extension の課金 

 

 データセットタイプ Extension の課金（拡張課金）は、申し込まれた契約タイプに応じた月額利用料で

す。月途中で契約タイプを変更した場合、当該月の最後に設定された契約タイプで課金されます。 

 

契約タイプ 月額利用

料 

月ごとのアップロード制約 月ごとのダウンロード制約 

サーバ数 回数 転送量 サーバ数 回数 転送量 

ミニマム 5,000 円 1 台 50 回 10 GB 1 台 200 回 40 GB 

スモール 10,000 円 10 台 500 回 100 GB 10 台 2,000 回 400 GB 

ミディアム 25,000 円 50 台 2,500 回 512 GB 50 台 10,000 回 2,048 GB 

ラージ 50,000 円 100 台 5,000 回 1,024 GB 100 台 20,000 回 4,096 GB 

なし      0 円 データセットタイプ Extension は利用できません 

 

利用開始時の契約タイプは「なし」となっています。データセットタイプ Extension を利用するために

は、Web サイトでの設定変更が必要です。詳細は後述の「Extension の有効化」を参照下さい。 

 

 ラージ以上のファイル転送が必要な場合、個別見積での対応となります。ご希望の場合、App Bridge サ

ポートまでご連絡下さい。 

  

https://docs.aws.amazon.com/ja_jp/AmazonS3/latest/dev/transfer-acceleration.html
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3.3.4 Extension のストレージ容量 

 

 データセットタイプ Extension のデータセットでアップロードを実行した場合、指定されたストレージ

にはアップロードされるファイル容量に加え、管理情報がアップロードされます。 

 

管理情報のサイズは、ピース数などによって増減します。ファイルサイズ 1GB あたりの管理情報サイズ

は、最大で 35KB 前後です。 

 

3.3.5 Extension のストレージ削除 

 

 データセットタイプ Extension のアップロード履歴で、データ削除が確定されてから、ストレージ上の

データが削除されるまでには、数分から数時間のタイムラグが発生します。 

 

  



 

- 11 - 

 

3.4 アップロード 

 

3.4.1 アップロードモジュール 

 

 本サービスでは、利用者向けに 2 つのアップロードモジュールを提供しています。2 つのモジュールの

アップロード機能に差はありません。 

 

モジュール 機能 利用場面 

アップロードコマンド 指定されたファイルを指定されたデー

タセットへアップロードします 

スクリプトなどに組み込まれたアッ

プロードを想定しています 

アップロードサービス 指定されたフォルダを監視し、対象ファ

イルを発見すると、当該ファイルを事前

に指定されたデータセットへアップロ

ードします 

ファイル作成をトリガーとするアッ

プロードを想定しています 

 

 
 

3.4.2 アップロードモジュールの障害検知 

 

 アップロードモジュールで障害を検知した場合、イベントログ/アプリケーションに Error ログを記録し

ます。App Bridge Monitor などの監視ツールを使用し、イベントログ/アプリケーションの Error ログ発

生を監視することで障害を検知することができます。 

 

3.4.3 アップロードのハートビートエラー 

 

 アップロードモジュールは、アップロードを開始すると、一定間隔で進捗状況を App Bridge センタに送

信します。 

App Bridge センタでは、アップロードモジュールの進捗情報送信が途切れると、ハートビートエラーを

発生させます。発生したハートビートエラーは、App Bridge Monitor を通じて通知されます。通知先や通

知方法は App Bridge Monitor で変更することが可能です。 

 

  

ファイル アップロード 
コマンド 

プログラム 

フォルダ 

監視 
ファイル出力 

アップロード 
サービス 

対象ファイルを発見すると 
アップロード 

指定されたファイルを 
アップロード 

Upload 

App Bridgeセンタ 

マップ 
情報 

Upload 
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3.4.4 アップロードのリラン指示 

 

 アップロードが失敗した場合、アップロード履歴に対し、Web サイトからリランを指示できます。アッ

プロードのリランは、前回アップロード状態を引き継ぎ、アップロード済みピースを再アップロードしま

せん。これにより、大容量ファイルのリラン時間を短縮することができます。 

 

 アップロードのリランを実施するには、以下の条件を満たす必要があります。 

 

⚫ アップロード失敗から 8 時間以上経過していない 

⚫ アップロード対象ファイルが変更されていない（ファイルサイズ、作成日時、更新日時が一致する） 

 

3.4.5 アップロードのリラン制御 

 

 アップロードのリランは、アップロードサービスが実施します。アップロードコマンドが実施したアッ

プロード履歴に対してリランを指示した場合でも、アップロードサービスがリランを実施します。このた

め、リランを実施するには、アップロードが失敗したサーバでアップロードサービスが稼働している必要

があります。 

 

 アップロードサービスは、定期的に App Bridge センタにアクセスし、同じホスト ID を持つリラン対象

のアップロード履歴がないかを確認します。対象のアップロード履歴を発見すれば、当該履歴をリラン対

象とします。 

 

 

 

  

App Bridgeセンタ 

マップ 
情報 

ファイル アップロード 
コマンド 

× 
失敗 

アップロード 
サービス 

リラン 

対象検出 

リラン 
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3.4.6 アップロードサービスのファイル処理 

 

 アップロードサービスは、設定に従って監視フォルダを監視し、対象ファイルを発見するとアップロー

ドします。対象ファイル発見後の一連動作は以下のとおりです。 

 

（１）ファイル更新終了確認 

 Write Watch Seconds（利用者設定値）を経過してもファイルが更新されない（ファイルサイズ、ファイ

ル更新日時が変化しない）ことを確認する。ファイルの更新が確認された場合、当該ファイルは処理対象

とはしない。処理対象とされなかったファイルは、次回のフォルダ監視で再度対象となる。 

 

（２）ファイルの移動 

 対象ファイルを 監視フォルダの Uploading サブフォルダ（Uploading/アップロード ID フォルダ） に移

動する。移動に失敗した場合、当該ファイルは処理対象とはしない。処理対象とされなかったファイルは、

次回のフォルダ監視で再度対象となる。 

 

（３）アップロード処理 

 アップロードを実行する。 

 

（４）終了処理 

 アップロードが正常に終了した場合、File Clean Type（利用者設定値）に従い、対象ファイルを処理（削

除、またはバックアップ）する。 

 

File Clean Type 対象ファイルの処理 

Backup 対象ファイルを監視フォルダの Backup サブフォルダ（Backup/アップロード ID フォ

ルダ）に移動する 

監視フォルダの Uploading サブフォルダ（Uploading/アップロード ID フォルダ）を

削除する 

Remove 対象ファイルを削除する 

監視ファイルの Uploading サブフォルダ（Uploading/アップロード ID フォルダ）を

削除する 

 

3.4.7 アップロード速度の調整 

 

 アップロードコマンドの引数、またはアップロードサービスの設定で指定された「使用ネットワークの

基準値」をもとに、ピースサイズを決定し、転送状況を確認しながら転送スレッド数を制御します。 

 

 転送速度が「使用ネットワークの基準値」を下回っていた場合は転送スレッドを追加し、「使用ネットワ

ークの基準値」を上回っていた場合は転送スレッドを停止することで、転送速度を調整します。 
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3.5 ダウンロード 

 

3.5.1 ダウンロードモジュール 

 

 本サービスでは、2 つのダウンロードモジュールを提供しています。 

 

モジュール 機能 利用場面 

ダウンロードコマンド 指定されたデータセット、アップロード

履歴のファイルをダウンロードします 

必要となった時点でダウンロードす

る場合を想定しています 

ダウンロードサービス 指定されたデータセットを監視し、新た

なアップロードを発見すると自動的に

ダウンロードします。ダウンロード完了

後、任意のプログラムを起動することも

可能です 

当該データセットにアップロードさ

れた全てのファイルを自動的にダウ

ンロードする場合を想定しています 

 

 

 

  

App Bridgeセンタ 

マップ 
情報 

Download ダウンロード 
コマンド 

ファイル 

ダウンロード 
サービス ファイル 

プログラム 

指定されたデータセットを 
ダウンロード 

アップロードを検知すると 
自動ダウンロード 

ダウンロードが終了すると 
任意のプログラムを起動 

Download 
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3.5.2 パイプラインダウンロード 

 

 パイプラインダウンロードは、ファイル全体のアップロード完了を待たず、最初のピースを発見すると

ダウンロードを開始する機能です。パイプラインダウンロードを使用することで、ダウンロード完了まで

の時間を短縮することができます 

 パイプラインダウンロードは、ダウンロードサービスのみで提供されます。 

 

3.5.3 ダウンロードモジュールの障害検知 

 

 ダウンロードモジュールで障害を検知した場合、イベントログ/アプリケーションに Error ログを記録し

ます。App Bridge Monitor などの監視ツールを使用し、イベントログ/アプリケーションの Error ログ発

生を監視することで障害を検知することができます。 

 また、ダウンロードサービスで、ダウンロード後のコマンド起動を指定している場合、コマンド起動に

失敗、またはリターンコードが正常でない場合も同様にイベントログ/アプリケーションの Error ログが記

録されます。 

 

3.5.4 ダウンロードのハートビートエラー 

 

 ダウンロードモジュールは、ダウンロードを開始すると、一定間隔で進捗状況を App Bridge センタに送

信します。App Bridge センタでは、ダウンロードモジュールの進捗情報送信が途切れると、ハートビート

エラーを発生させます。発生したハートビートエラーは、App Bridge Monitor を通じて通知されます。通

知先や通知方法は App Bridge Monitor で変更することが可能です。 

 

3.5.5 ダウンロードのリラン指示 

 

 ダウンロードが失敗した場合、ダウンロード履歴に対し、Web サイトからリランを指示できます。ダウ

ンロードのリランは、前回ダウンロード状態を引き継ぎ、ダウンロード済みピースを再ダウンロードしま

せん。これにより、大容量ファイルのリラン時間を短縮することができます。 

 

 ダウンロードのリランを実施するには、以下の条件を満たす必要があります。 

 

⚫ ダウンロード失敗から 8 時間以上経過していない 

⚫ ダウンロード中間ファイルが存在する 
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3.5.6 ダウンロードのリラン制御 

 

 ダウンロードのリランは、ダウンロードサービスが実施します。ダウンロードコマンドが実施したダウ

ンロード履歴に対してリランを指示した場合でも、ダウンロードサービスがリランを実施します。このた

め、リランを実施するには、ダウンロードが失敗したサーバでダウンロードサービスが稼働している必要

があります。 

 

 ダウンロードサービスは、定期的に App Bridge センタにアクセスし、同じホスト ID を持つリラン対象

のダウンロード履歴がないかを確認します。対象のダウンロード履歴を発見すれば、当該履歴をリラン対

象とします。 

 

 

 

3.5.7 ダウンロードファイルの処理 

 

 ダウンロード中、ダウンロードファイルは、指定されたフォルダに拡張子.tmp の一意なファイル名を用

いて中間ファイルとして作成され、ダウンロード終了時に指定のファイル名にリネームされます。 

ダウンロード中に障害が発生した場合、拡張子.tmp の中間ファイルはそのまま残り、リラン時に使用さ

れます。中間ファイルは、一定期間経過後、ダウンロードサービスによって削除されます。 

 

3.5.8 ダウンロード速度の調整 

 

 ダウンロードコマンドの引数、またはダウンロードサービスの設定で指定された「使用ネットワークの

基準値」をもとに、ピースサイズを決定し、転送スレッド数を制御します。 

 

 ピースサイズは、アップロード時のピースサイズより大きくすることはできません。ピースサイズがア

ップロード時のピースサイズを下回った場合、ピースを分割してダウンロードを実施します。 

 

 実際の転送速度が「使用ネットワークの基準値」を下回っていた場合は転送スレッドを追加し、「使用ネ

ットワークの基準値」を上回っていた場合は転送スレッドを停止することで、転送速度を調整します。 
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対象検出 
リラン 
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3.5.9 ダウンロードサービスの抽出範囲 

 

 ダウンロードサービスは、アップロード終了日時が以下の範囲にあるアップロードをダウンロード対象

とします。 

 

⚫ アップロード終了日時 ＞ ダウンロードサービスが当該データセットを監視対象とした時刻 

⚫ アップロード終了日時 ＜ 現在時刻 － 30 秒  

 

 ダウンロードサービス停止中に終了したアップロードは、次回ダウンロードサービス起動後にダウンロ

ード対象となります。 
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3.6 暗号化方式 

 

3.6.1 サーバサイド暗号 

 

 クラウドストレージ側で準備された暗号化を使用する方式です、暗号キーは本サービスが生成し、暗号

化をクラウドストレージ側で実施します。 

 

クラウドストレージ側で暗号化/復号化されるため、アップロードサーバ、ダウンロードサーバの CPU 消

費が抑えられます。 

 

サーバサイド暗号化の可否はクラウドストレージによって異なります。現在サポートしている Amazon S3

ではサーバサイト暗号を使用することができ、Amazon S3 で暗号キーは保存されません。 

 

3.6.2 クライアントサイド暗号 

 

 本サービスが独自に暗号化を実施する方式です。暗号化後のデータがクラウドストレージに出力されま

す。暗号化/復号化がアップロードサーバ、ダウンロードサーバで実施されるため、サーバサイド暗号と比

較し、CPU が消費されます。 
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４．データセットの操作 

 

4.1 ファイル転送設定サイトの表示 

 

 App Bridge Transporter の各種設定は、ファイル転送設定サイトから実施します。当該サイトを表示す

るためには、App Bridge Web サイトにログインし、メニューから「App Bridge Transporter/ファイル転

送設定」を選択します。 
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4.2 データセット登録（Standard） 

 

 データセットを登録するには、ファイル転送設定サイトのメニュー「Dataset List」を選択し、 [Create]

ボタンをクリックします。 

 

 

 

 データセットタイプ選択画面が表示された場合、データセットタイプに Standard を選択し、[Next]ボタ

ンをクリックします。 

 

 

 

本画面は、Extension が有効化されていないとき、表示されません。 
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 表示された「Dataset Create」画面に、項目を入力し、[OK]ボタンをクリックします。 

 

 

 

項目 内容 

Dataset CD データセットを一意に表すデータセット CD を指定します（※1） 

Dataset Name データセットの内容を示す名称を指定します（※2） 

Allow Upload アップロードを許可する場合、チェックします 

Dataset Type 選択したデータセットタイプが表示されます。本項目はあとで

変更できません 

Upload Timeout (min.) アップロードハートビートエラーが発生するまでの無通信期間

（分）で指定します 

Upload Timeout Repeat (min.) アップロードハートビートエラーを繰り返す場合、繰り返し間

隔（分）を指定します 

Download Timeout (min.) ダウンロードハートビートエラーが発生するまでの無通信期間

（分）で指定します 

Download Timeout Repeat (min.) ダウンロードハートビートエラーを繰り返す場合、繰り返し間

隔（分）を指定します 

Allow Other Link Users to Upload ファイルアップロードが許可された全てのユーザに当該データ

セットへのアップロードを許可する場合、チェックします。詳

細は後述の「リンクユーザ設定」を参照下さい 

Allow Other Link Users to Download ファイルアップロードが許可された全てのユーザに当該データ

セットへのアップロードを許可する場合、チェックします。詳

細は後述の「リンクユーザ設定」を参照下さい 

Data Retention Period (days) アップロードされたファイルの保存期間を指定します。保存期

間を経過したファイルは削除されます 

Maximum Number of Generations アップロードされたファイルを世代管理する場合、最大世代数

を指定します。世代数を超えるファイルがアップロードされた

場合、古いファイルから順に削除されます 

Allow Pipeline Download パイプラインダウンロードを許可する場合、チェックします 

※1：許可文字数は 1 文字～32 文字、許可文字種：英字、数字、_（アンダースコア）の何れか、英字小文

字は英字大文字に変換されます 

※2：許可文字数：1 文字～50 文字、許可文字種：サロゲートペア文字以外 
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4.3 リンクユーザ設定 

 

 データセット別にユーザのアクセス権を制御したい場合、リンクユーザを設定します。ユーザの登録権

限（ファイルアップロード許可、ファイルダウンロード許可）に従って全データセットを制御する場合は、

リンクユーザ設定は不要です。 

 

4.3.1 指定ユーザのみにアクセスを許可する 

 

 指定ユーザのみにアップロード、ダウンロードを許可する場合、データセットの「Allow Other Link Users 

to Upload」、「Allow Other Link Users to Download」をチェックオフとし、リンクユーザ設定で特定ユー

ザにアクセス権を与えます。 

 

 ファイル転送設定画面のメニュー「Dataset List」を選択し、対象のデータセット CD をクリックします。 

 

 

 

 表示されたデータセット情報画面で、[Update]をクリックします。 
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 表示された画面で、「Allow Other Link Users to Upload」、「Allow Other Link Users to Download」の

チェックを外し、[OK]ボタンをクリックします。これでリンクユーザに登録されていないユーザは当該デ

ータセットにアクセスできなくなります。 

 

 
 表示されたデータセット情報画面で、[Add Link User]ボタンをクリックします。 
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 表示された画面で、アップロードを許可したいユーザを選択し、「Allow Upload」をチェックして、[OK]

ボタンをクリックします。 

 

 

 

 続けて同様に、ダウンロードを許可したいユーザを選択し、「Allow Download」をチェックして、[OK]

ボタンをクリックします。 

 

 
 この設定により、リンクユーザで許可されたユーザのみが当該データセットにアクセスできます。 
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4.3.2 指定ユーザのアクセスを拒否する 

 

 指定ユーザのアクセス権を拒否したい場合、データセットの「Allow Other Link Users to Upload」、「Allow 

Other Link Users to Download」をチェックオンとし、リンクユーザ設定で拒否します。 

 

データセットの「Allow Other Link Users to Upload」、「Allow Other Link Users to Download」をチ

ェックオンとし、データセット情報画面で、[Add Link User]ボタンをクリックします。 

 

 
 

 アクセスを拒否したいユーザを選択し、「Allow Upload」、「Allow Download」の何れか、または両方のチ

ェックを外します。これにより、当該ユーザは、リンクユーザで設定した権限に従って、アクセスが拒否

されます。 
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4.4 Extension の有効化 

 

4.4.1 契約タイプの設定 

 

 データセットタイプ Extension を有効とするためには、Web サイトに NodeAdmin 以上の権限でログイン

し、ファイル転送サイトのメニュー「Administration」を選択し、表示された画面の Extension Type をク

リックします。 

 

 

 

 表示された画面で、任意の契約タイプを選択し、[OK]ボタンをクリックします。Extension の課金は本

設定を実施した時点で開始されます。詳細は前述の「Extension の課金」を参照下さい。 
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4.4.2 ストレージの準備 

 

 データセットタイプ Extension を実施する場合、利用者がストレージを準備する必要があります。 

 

 Amazon S3 を利用する場合、専用のバケットを作成して下さい。 

 

4.4.3 アクセスキーの登録 

 

データセットを作成する前に、該当ストレージに対して、データの読み取り、追加、変更、削除権限を

持つアカウントを準備し、当該アカウントのアクセスキーを登録する必要があります。 

 

 Amazon S3 を利用する場合、当該バケットに対するフルアクセス権を持つアカウントのアカウントキー

ID、シークレットアクセスキーを登録します。 

 

 アカウントキーID を登録するためには、App Bridge Web サイトにログインし、メニューから

「Credentials/AWS 認証情報管理」を選択し、表示された画面から登録します。 

 

 
 

 アクセスキーID 登録の詳細は、以下のマニュアルを参照下さい。 

 

⚫ App Bridge 認証管理ガイド 
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4.5 データセット登録（Extension） 

 

 データセットを登録するには、ファイル転送設定サイトのメニュー「Dataset List」を選択し、 [Create]

ボタンをクリックします。 

 

 
 

 表示されたデータセットタイプ選択画面で、データセットタイプに Extension を選択し、[Next]ボタン

をクリックします。 

 

 

 

 表示されたストレージ選択画面で、ストレージタイプに Amazon S3 を選択し、[Next]ボタンをクリック

します。 
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 表示された「Dataset Create」画面に、項目を入力し、[OK]ボタンをクリックします。Storage Type～

AWS Credential までの項目は、Extension 専用の項目です。 

 

 
 

項目 内容 

Dataset CD データセットを一意に表すデータセット CD を指定します（※1） 

Dataset Name データセットの内容を示す名称を指定します（※2） 

Allow Upload アップロードを許可する場合、チェックします 

Dataset Type 選択したデータセットタイプが表示されます。本項目はあとで

変更できません 

Storage Type 選択したストレージタイプが表示されます。本項目はあとで変

更できません 

AWS Region 使用するバケットが存在する AWS リージョンを選択します 

S3 Bucket Name 使用するバケット名を指定します 

S3 Server-Side Encoding サーバサイド暗号を使用する場合、チェックします。チェック

しない場合、クライアント暗号が使用されます 

AWS Credential [Select AWS Credential]ボタンをクリックし、使用するアクセ

スキーを指定します。使用するアクセスキーは事前の登録が必

要です 

Upload Timeout (min.) アップロードハートビートエラーが発生するまでの無通信期間

（分）で指定します 

Upload Timeout Repeat (min.) アップロードハートビートエラーを繰り返す場合、繰り返し間

隔（分）を指定します 

Download Timeout (min.) ダウンロードハートビートエラーが発生するまでの無通信期間

（分）で指定します 
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Download Timeout Repeat (min.) ダウンロードハートビートエラーを繰り返す場合、繰り返し間

隔（分）を指定します 

Allow Other Link Users to Upload ファイルアップロードが許可された全てのユーザに当該データ

セットへのアップロードを許可する場合、チェックします。詳

細は後述の「リンクユーザ設定」を参照下さい 

Allow Other Link Users to Download ファイルアップロードが許可された全てのユーザに当該データ

セットへのアップロードを許可する場合、チェックします 

Data Retention Period (days) アップロードされたファイルの保存期間を指定します。保存期

間を経過したファイルは削除されます 

Maximum Number of Generations アップロードされたファイルを世代管理する場合、最大世代数

を指定します 

Allow Pipeline Download パイプラインダウンロードを許可する場合、チェックします 

※1：許可文字数は 1 文字～32 文字、許可文字種：英字、数字、_（アンダースコア）の何れか、英字小文

字は英字大文字に変換されます 

※2：許可文字数：1 文字～50 文字、許可文字種：サロゲートペア文字以外 
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５．アップロードの操作 

 

5.1 アップロードサーバの設定 

 

5.1.1 モジュールインストール 

 

 アップロードを実施するためには、対象のサーバにモジュールをインストールする必要があります。 

 

（１）アップロードモジュールのダウンロード 

 対象のセットアップファイルを以下のサイトからダウンロードし、解凍します。 

 

http://www.app-bridge.com/Setup_Transporter.html 

 

ダウンロードファイル 含まれるセットアップファイル 備考 

SetupDTSUpload_v011900.zip SetupDTSUpload.msi  

 

（２）共通モジュールのダウンロード 

 対象のセットアップファイルを以下のサイトからダウンロードし、解凍します。 

 

http://www.app-bridge.com/Setup_Tools.html 

 

ダウンロードファイル 含まれるセットアップファイル 備考 

SetupABMAPIConfig_v011900.zip SetupABMAPIConfig.msi ※1 

SetupABMSupport_v011900.zip SetupABMSupport.msi ※1、※2 

※1：同セットアップが既にインストールされているとき、不要です 

※2：App Bridge Monitor Windows Agent がインストールされているとき、不要です 

 

（３）インストール 

 解凍したセットアップを実行し、示されたウィザードに従って、インストールを実施します。 

 

 

  

http://www.app-bridge.com/Setup_Transporter.html
http://www.app-bridge.com/Setup_Transporter.html
http://www.app-bridge.com/Setup_Tools.html
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5.1.2 ユーザアカウント設定 

 

 サーバのメニューから、[スタート]→[App Bridge API]→[API Configuration]を選択し、表示された画

面でアップロードモジュールがアクセスに使用するユーザアカウント情報を設定します。 

 

 

 

# 項目 内容 備考 

1 FQDN App BridgeセンタにアクセスするためのFQDN mercury-api.app-bridge.com を

指定下さい 

2 Port App Bridge センタにアクセスするためのポー

ト番号 

443 を指定下さい 

3 Primary Owner CD ユーザが所属するオーナコード 課金オーナ CD を指定します 

4 User CD アクセスに使用するユーザコード  

5 Password ユーザのパスワード  

6 Proxy プロキシサーバを経由する場合、本ボタンを

クリックしプロキシ情報を設定します。 

※1 

7 Check App Bridge センタと通信し、通信状態を確認

します 

 

※1：プロキシ設定の詳細は、App Bridge Windows Agent プロキシ設定ガイドを参照下さい 

 

 サーバに設定できるユーザアカウントは 1 つです。同じサーバでアップロードとダウンロードの両方を

実施する場合、設定するアカウントにはアップロード、ダウンロード、両方の権限が必要です。 
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5.1.3 コマンドのパス確認と環境変数設定 

 

 アップロードコマンドは、インストールフォルダの CLI サブフォルダに格納されている DTSUploadCmd で

す。 

 

 
 

 サーバのメニューから[スタート]→[App Bridge Transporter Upload]→[User Environment Variable 

[PATH]→[Enter CLI Folder]を選択すると、CLI フォルダをユーザレベルの環境変数 PATH の末尾に登録し

ます。必要に応じて実行下さい。 
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5.1.4 サービスの起動 

 

 インストール直後、アップロードサービスは停止しているため、これを起動します。 

サーバのメニューから[スタート]→[App Bridge Transporter Upload]→[Upload Setting]を選択し、

Upload Setting フォームを起動します。起動した UploadSetting フォームのメニューから[Service]→

[Start]を選択し、アップロードサービスを起動します。サービスの起動状態は、Upload Setting フォー

ム画面下部のステータスストリップに表示されます。 

 

 

 

 
 

 コマンドでのアップロードについても、リラン処理、不要ファイル削除をアップロードサービスが実施

します。アップロードサービスは必ず起動して下さい。 
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5.1.5 モジュールのアンインストール 

 

（１）サービス停止 

サーバのメニューから[スタート]→[App Bridge Transporter Upload]→[Upload Setting]を選択し、

Upload Setting フォームを起動します。起動した UploadSetting フォームのメニューから[Service]→

[Stop]を選択し、アップロードサービスを停止します。 

 

 
 

（２）環境変数 PATH からの削除 

 CLI フォルダをユーザレベルの環境変数 PATH に登録している場合、サーバのメニューから[スタート]→

[App Bridge Transporter Upload]→[User Environment Variable [PATH]→[Remove CLI Folder]を選択し、

ユーザレベルの環境変数 PATH から CLI フォルダを削除します。 

 

（３）アンインストール 

 「コントロールパネル」－「プログラムと機能」で「App Bridge Transporter Upload」を選択し、アン

インストールします。 

 

5.1.6 モジュールのアップグレード 

 

 アップロードモジュールをアップグレードする場合、アンインストールを実行したのち、再度新しいバ

ージョンのインストールを実行してください。設定情報は引き継がれます。 

 

 ダウングレード（古いバージョンのインストール）は保証していません。 
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5.2 アップロードコマンド 

 

 指定されたファイルを、指定されたデータセットにアップロードします。 

 

5.2.1 コマンド様式 

 

 

 

引数 内容 仮定値 

/oc オーナ CD を指定する 課金オーナ CD 

/dc データセット CD を指定する 必須 

/if 入力ファイルパスを指定する。以下の代替文字列が使用可能 

代替文字列 内容 

%DATE-YYYY% 当日（UTC）の年（4 桁） 

%DATE-MM% 当日（UTC）の月（2 桁） 

%DATE-DD% 当日（UTC）の日（2 桁） 

%DATE-XXX-YYYY% 当日（UTC）から XXX シフトした年 

%DATE-XXX-MM% 当日（UTC）から XXX シフトした月 

%DATE-XXX-DD% 当日（UTC）から XXX シフトした日 

%LDATE-YYYY% 当日（ローカル）の年（4 桁） 

%LDATE-MM% 当日（ローカル）の月（2 桁） 

%LDATE-DD% 当日（ローカル）の日（2 桁） 

%LDATE-XXX-YYYY% 当日（ローカル）から XXX シフトした年 

%LDATE-XXX-MM% 当日（ローカル）から XXX シフトした月 

%LDATE-XXX-DD% 当日（ローカル）から XXX シフトした日 
 

必須 

 

XXX は以下のとおり 

D01～D10：01～10 日前 

M01～M12：01～12 か月前 

 

/nb 使用するネットワーク帯域の基準値（Mbps）を 8～1024 の 8 の倍

数で指定する 

128（Mbps） 

/we エラーをイベントログに出力する場合 True を指定する True 

/ta S3 Transfer Acceleration を使用する場合 True を指定する。 

Standard のデータセットでは True を指定できない 

False 

/q Quiet モード（応答確認なし）を使用する False 

 

5.2.2 リターンコード 

 

リターンコード 内容 備考 

0 正常終了  

8 引数エラーが発生した  

12 予期せぬエラーが発生した  

 

  

DTSUploadCmd  [/oc ownercd] 
/dc datasetcd 

    /if inputfilepath 
          [/nb networkbandwidth] 
    [/we (true|false) 
    [/ta (true|false)] 
    [/q (true|false)] 
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5.3 アップロードサービス 

 

5.3.1 監視フォルダの登録 

 

 監視対象のフォルダを登録するには、サーバのメニューから[スタート]→[App Bridge Transporter 

Upload]→[Upload Setting]を選択し、Upload Setting フォームを起動します。起動した UploadSetting

フォームのメニューから[Edit]→[Add Object]を選択し、表示された画面に従ってアップロード情報を指

定し、[OK]ボタンをクリックします。 

 

 
 

項目 内容 

Folder Path 監視するフォルダパスを指定する 

File Mask 対象のファイルマスクを指定する 

Write Watch Seconds ファイルの出力待ち時間を指定する（※1） 

File Clean Type Backup、または Remove を選択する（※1） 

Owner CD アップロードするオーナ CD を指定する 

Dataset CD アップロードするデータセット CD を指定する 

Network Bandwidth Average Level 使用するネットワーク帯域の基準値（Mbps）を 8～1024 の 8 の

倍数で指定する 

Transfer Acceleration S3 Transfer Acceleration を使用する場合チェックする。 

Standard のデータセットではチェックできない 

Enable このフォルダ監視を有効とする場合チェックする 

※1：詳細は前述の「アップロードサービスのファイル処理」を参照下さい 
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5.3.2 設定の保存と反映 

 

 UploadSetting フォームのメニューから[File]→[Save]を選択し、更新内容を保存します。 

 

 
 

 UploadSetting フォームのメニューから[Service]→[Stop]、[Service]→[Start]を実行し、アップロー

ドサービスを再起動します。これにより、更新された内容をアップロードサービスが認識し、フォルダの

監視が開始されます。 
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5.3.3 Backup フォルダのファイル削除 

 

 アップロードサービスが監視フォルダに作成した Backup フォルダのアップロード済みファイルは、その

まま保存され続けます。任意のタイミングでクリーンアップを実施して下さい。 

 

 同じサーバに App Bridge Monitor Windows Agent を導入いただいている場合、Agent のファイル削除機

能で、一定期間が経過した Backup フォルダのアップロード済みファイルを削除することができます。 

 App Bridge Monitor Windows Agent でバックアップフォルダのアップロード済みファイルを削除するに

は、サーバのメニューから[スタート]→[App Bridge Monitor]→[Service Control]を選択し、Service 

Control フォームを起動します。Service Control のメニューで[Setting]→[Condition Service]→[File 

Remove]を選択します。 

 

 

 

 表示された File Remove 画面で、[Add]ボタンをクリックし、表示された File Remove Settings 画面で

内容を設定します。 

 

 

 

項目 内容 

Folder Path 監視フォルダの Backup フォルダを指定する 

File Mask *.*を指定する 

Keep Limit 任意の保存期間を指定する 

Sub Folder Remove Type [Remove Files & Empty Folder]を選択する。これにより Backup フォルダ

に作成されたサブフォルダ（アップロード ID）も削除される 
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5.4 アップロード履歴 

 

 アップロードが開始されると、アップロード履歴が作成されます。アップロード履歴を確認するには、

ファイル転送設定サイトのメニュー「Upload List」を選択します。 

 表示されたアップロード履歴の Dataset CD をクリックするとデータセット定義が、Upload Start Time

をクリックするとアップロード情報が表示されます。 

 

 

 

 表示されるステータスを以下に示します。 

 

ステータス 状態 備考 

Uploading アップロード中  

Complete アップロード完了  

Abort アップロード異常終了  

Canceling キャンセル要求中 利用者トリガー、Agent 処理待ち 

Canceled キャンセル完了  

WaitingRetry リトライ要求中 利用者トリガー、Agent 処理待ち 

 

 

  

データセット定義画面へ アップロード情報画面へ 
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5.5 アップロード情報 

 

 アップロード情報画面には、アップロード関連の各種情報が表示されます。 

 

 

 

 Web サイトにログインしたユーザが、当該データセットに対するアップロード権限を持つとき、以下の

操作が可能です。各種ボタンは実行可能な場合に表示されます。 

 

ボタン 内容 備考 

Cancel Upload ダウンロード実行中の Agent に中止を要求する。ス

テータスは Canceling となり、Agent が処理を中止

すると Canceled となる 

 

Force Cancel ステータスをCancelingからCanceledに強制変更す

る 

Agent ダウン時に使用 

Retry Upload Agent にアップロードの再開を要求する。ステータ

スは WaitingRetry となり、Agent が処理を開始する

と Uploading となる 

 

Disable Download Complete しているアップロードのダウンロードを

抑止する 

 

Allow Download 抑止されているダウンロードを許可する  

Delete Data クラウドストレージ上のデータを削除する。

「Specify Delete Time」が選択された場合、指定時

刻に削除される 

 

Cancel Delete 指定されている削除予定を解除する  
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６．ダウンロードの操作 

 

6.1 ダウンロードサーバの設定 

 

6.1.1 モジュールインストール 

 

 ダウンロードを実施するためには、対象のサーバにモジュールをインストールする必要があります。 

 

（１）ダウンロードモジュールのダウンロード 

 対象のセットアップファイルを以下のサイトからダウンロードし、解凍します。 

 

http://www.app-bridge.com/Setup_Transporter.html 

 

ダウンロードファイル 含まれるセットアップファイル 備考 

SetupDTSDownload_v011900.zip SetupDTSDownload.msi  

 

（２）共通モジュールのダウンロード 

 対象のセットアップファイルを以下のサイトからダウンロードし、解凍します。 

 

http://www.app-bridge.com/Setup_Tools.html 

 

ダウンロードファイル 含まれるセットアップファイル 備考 

SetupABMAPIConfig_v011900.zip SetupABMAPIConfig.msi ※1 

SetupABMSupport_v011900.zip SetupABMSupport.msi ※1、※2 

※1：同セットアップが既にインストールされているとき、不要です 

※2：App Bridge Monitor Windows Agent がインストールされているとき、不要です 

 

（３）インストール 

 解凍したセットアップを実行し、示されたウィザードに従って、インストールを実施します。 

 

 
 

  

http://www.app-bridge.com/Setup_Transporter.html
http://www.app-bridge.com/Setup_Transporter.html
http://www.app-bridge.com/Setup_Tools.html
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6.1.2 ユーザアカウント設定 

 

 サーバのメニューから、[スタート]→[App Bridge API]→[API Configuration]を選択し、表示された画

面でアップロードモジュールがアクセスに使用するユーザアカウント情報を設定します。 

 

 

 

# 項目 内容 備考 

1 FQDN App BridgeセンタにアクセスするためのFQDN mercury-api.app-bridge.com を

指定下さい 

2 Port App Bridge センタにアクセスするためのポー

ト番号 

443 を指定下さい 

3 Primary Owner CD ユーザが所属するオーナコード 課金オーナ CD を指定します 

4 User CD アクセスに使用するユーザコード  

5 Password ユーザのパスワード  

6 Proxy プロキシサーバを経由する場合、本ボタンを

クリックしプロキシ情報を設定します 

※1 

7 Check App Bridge センタと通信し、通信状態を確認

します 

 

※1：プロキシ設定の詳細は、App Bridge Windows Agent プロキシ設定ガイドを参照下さい 

 

 サーバに設定できるユーザアカウントは 1 つです。同じサーバでアップロードとダウンロードの両方を

実施する場合、設定するアカウントにはアップロード、ダウンロード、両方の権限が必要です。 
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6.1.3 コマンドのパス確認と環境変数設定 

 

 ダウンロードコマンドは、インストールフォルダの CLI サブフォルダに格納されている DTSDownloadCmd

です。 

 

 

 

 サーバのメニューから[スタート]→[App Bridge Transporter Download]→[User Environment Variable 

[PATH]→[Enter CLI Folder]を選択すると、CLI フォルダをユーザレベルの環境変数 PATH の末尾に登録し

ます。必要に応じて実行下さい。 
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6.1.4 サービスの起動 

 

 インストール直後、ダウンロードサービスは停止しているため、これを起動します。 

サーバのメニューから[スタート]→[App Bridge Transporter Download]→[Download Setting]を選択し、

Download Setting フォームを起動します。起動した DownloadSetting フォームのメニューから[Service]

→[Start]を選択し、ダウンロードサービスを起動します。サービスの起動状態は、Download Setting フ

ォーム画面下部のステータスストリップに表示されます。 

 

 

 

 

 

 

 

 コマンドでのダウンロードについても、リラン処理、不要ファイル削除をダウンロードサービスが実施

します。ダウンロードサービスは必ず起動して下さい。 
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6.1.5 モジュールのアンインストール 

 

（１）サービス停止 

サーバのメニューから[スタート]→[App Bridge Transporter Download]→[Download Setting]を選択し、

Download Setting フォームを起動します。起動した UploadSetting フォームのメニューから[Service]→

[Stop]を選択し、アップロードサービスを停止します。 

 

 

 

（２）環境変数 PATH からの削除 

 CLI フォルダをユーザレベルの環境変数 PATH に登録している場合、サーバのメニューから[スタート]→

[App Bridge Transporter Download]→[User Environment Variable [PATH]→[Remove CLI Folder]を選択

し、ユーザレベルの環境変数 PATH から CLI フォルダを削除します。 

 

（３）アンインストール 

 「コントロールパネル」－「プログラムと機能」で「App Bridge Transporter Download」を選択し、ア

ンインストールします。 

 

6.1.6 モジュールのアップグレード 

 

 ダウンロードモジュールをアップグレードする場合、アンインストールを実行したのち、再度新しいバ

ージョンのインストールを実行してください。設定情報は引き継がれます。 

 

 ダウングレード（古いバージョンのインストール）は保証していません。 

 

  



 

- 47 - 

 

6.2 ダウンロードコマンド 

 

 指定されたデータセットからダウンロードします。 

 

6.2.1 コマンド様式 

 

 

 

引数 内容 仮定値 

/oc オーナ CD を指定する 課金オーナ CD 

/dc データセット CD を指定する 必須 

/uid アップロード ID を指定する ※1 

/of 出力ファイルパスを指定する。後述の代替文字列が使用できる 必須 

/nb 使用するネットワーク帯域の基準値（Mbps）を 8～1024 の 8 の倍

数で指定する 

128（Mbps） 

/we エラーをイベントログに出力する True 

/ta S3 Transfer Acceleration を使用する場合 True 

DatasetType：Standard のデータセットでは指定できない 

False 

/q Quiet モード（応答確認なし）を使用する False 

※1：指定されたデータセットのアップロード履歴のうち、Status が Complete で最も大きなアップロード

終了日時を持つアップロード ID を仮定する 

 

6.2.2 リターンコード 

 

リターンコード 内容 備考 

0 正常終了  

8 引数エラーが発生した  

12 予期せぬエラーが発生した  

 

  

DTSDownloadCmd [/oc ownercd] 
/dc datasetcd 
[/uid uploadid] 

    /of outputfilepath 
          [/nb networkbandwidth] 
    [/we (true|false) 
    [/ta (true|false)] 
    [/q (true|false)] 
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6.3 ダウンロードサービス 

 

6.3.1 監視データセットの登録 

 

 監視対象のデータセットを登録するには、サーバのメニューから[スタート]→[App Bridge Transporter 

Download]→[Download Setting]を選択し、Download Setting フォームを起動します。起動した

DownloadSetting フォームのメニューから[Edit]→[Add Object]を選択し、表示された画面に従ってダウ

ンロード情報を指定し、[OK]ボタンをクリックします。 

 

 
 

 表示された画面に監視対象のオーナとデータセットを指定します。 
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 表示された画面の Output File タブ、Performance タブ、Command タブに出力ファイルの情報を指定し、

[OK]ボタンをクリックします。 

 

 

 

タブ 項目 内容 

Output File Folder Path 出力ファイルのフォルダパスを指定する（※1） 

File Name 出力ファイルのファイル名を指定する（※1） 

Rewrite 出力ファイルを上書き保存する場合チェックする 

Performance Network Bandwidth 

Average Level 

使用するネットワーク帯域の基準値（Mbps）を 8～1024 の 8 の

倍数で指定する 

Transfer Acceleration S3 Transfer Acceleration を使用する場合チェックする。 

Standard のデータセットではチェックできない 

Command Use Command ダウンロード後にコマンドを起動する場合チェックする（※2） 

Command Path 起動するコマンドのパスを指定する 

Command Arguments コマンドに渡す引数を指定する（※1） 

Working Directory Path コマンドのワーキングフォルダパスを指定する。指定されない

場合、起動コマンドが存在するフォルダを仮定する 

Accept Return Codes 正常と見なすリターンコードを CSV 形式で指定する 

Enable このデータセット監視を有効とする場合チェックする 

※1：後述の代替文字列が使用できる 

※2：コマンドの起動に失敗した場合、またはリターンコードが正常でなかった場合、イベントログにエラ

ーが記録される 
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6.3.2 設定の保存と反映 

 

 DownloadSetting フォームのメニューから[File]→[Save]を選択し、更新内容を保存します。 

 

 

 

 DownloadSetting フォームのメニューから[Service]→[Stop]、[Service]→[Start]を実行し、ダウンロ

ードサービスを再起動します。これにより、更新された内容をダウンロードサービスが認識し、データセ

ットの監視が開始されます。 
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6.4 代替文字列 

 

 使用できる代替え文字列は以下のとおりです。 

 

代替文字列 内容 備考 

%UPLOADFILENAME% アップロード時のファイル名  

%DATE-YYYY% 当日（UTC）の年（4 桁）  

%DATE-MM% 当日（UTC）の月（2 桁）  

%DATE-DD% 当日（UTC）の日（2 桁）  

%DATE-XXX-YYYY% 当日（UTC）から XXX シフトした年 ※1 

%DATE-XXX-MM% 当日（UTC）から XXX シフトした月 ※1 

%DATE-XXX-DD% 当日（UTC）から XXX シフトした日 ※1 

%LDATE-YYYY% 当日（ローカル）の年（4 桁）  

%LDATE-MM% 当日（ローカル）の月（2 桁）  

%LDATE-DD% 当日（ローカル）の日（2 桁）  

%LDATE-XXX-YYYY% 当日（ローカル）から XXX シフトした年 ※1 

%LDATE-XXX-MM% 当日（ローカル）から XXX シフトした月 ※1 

%LDATE-XXX-DD% 当日（ローカル）から XXX シフトした日 ※1 

※1：XXX は以下のとおり 

D01～D10：01～10 日前 

M01～M12：01～12 か月前 
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6.5 ダウンロード履歴 

 

 ダウンロードが開始されると、ダウンロード履歴が作成されます。ダウンロード履歴を確認するには、

ファイル転送設定サイトのメニュー「Download List」を選択します。 

 表示されたダウンロード履歴の Dataset CD をクリックするとデータセット定義、Download Start Time

をクリックするとダウンロード情報、Upload Start Time をクリックするとアップロード情報が表示され

ます。 

 

 

 

 

 表示されるステータスを以下に示します。 

 

ステータス 状態 備考 

Downloading ダウンロード中  

Complete ダウンロード完了  

Abort ダウンロード異常終了  

Canceling キャンセル要求中 利用者トリガー、Agent 処理待ち 

Canceled キャンセル完了  

WaitingRetry リトライ要求中 利用者トリガー、Agent 処理待ち 

 

 

  

データセット定義画面へ 

アップロード情報画面へ 

ダウンロード情報画面へ 



 

- 53 - 

 

6.6 ダウンロード情報 

 

 ダウンロード情報画面には、ダウンロード関連の各種情報が表示されます。 

 

 

 

 Web サイトにログインしたユーザが、当該データセットに対するダウンロード権限を持つとき、以下の

操作が可能です。各種ボタンは実行可能な場合に表示されます。 

 

ボタン 内容 備考 

Cancel Download ダウンロード実行中の Agent に中止を要求する。ス

テータスは Canceling となり、Agent が処理を中止

すると Canceled となる 

 

Force Cancel ステータスをCancelingからCanceledに強制変更す

る 

Agent ダウン時に使用 

Retry Download Agent にダウンロードの再開を要求する。ステータ

スは WaitingRetry となり、Agent が処理を開始する

と Downloading となる 
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